MailEnable Connector for Microsoft Outlook
Version 1.41
This guide describes the installation and functionality of the MailEnable Connector for Microsoft
Outlook.

Features
The MailEnable Connector for Microsoft Outlook has the following features:
Full integration of email, appointments, tasks and address book
Server side file management and integration with My Files on web mail
Connect to other users resources
Configure permissions for folders for other users
Set out of office message
Offline support
Support for SSL connections to the server

Requirements
The server must be MailEnable Enterprise Premium 4 or later. For the client application, you can use
the following:
Microsoft Outlook 2003
Microsoft Outlook 2007
Microsoft Outlook 2010 (32bit and 64bit versions)

Installation
Close Microsoft Outlook and run the installation application for the connector.

Server Configuration
The MailEnable connector communicates to the MailEnable server via the IMAP and SMTP services.
A default installation would require the client machine to access the server over ports 143 and 25,
although this is configurable. If SSL is being used, the client port configuration must match the server
SSL port configuration.

Creating an Account
When adding to an existing profile in Outlook 2007:
1.
2.
3.
4.

Select Account Settings from the Tools menu.
Select the New… link to create a new account.
Select Other and the MailEnable Server option, then select Next
4. You can now configure the settings for connecting and accessing the MailEnable Server.
These follow below:
4.1 In the Server Address textbox, specify the host name or IP address of the server running
MailEnable.
4.2 For the User Name you should supply your login in the form of mailbox@postoffice.

4.3
4.4
4.5
4.6

Enter the corresponding password for the above login
Enter your friendly name - typically first name followed by surname
Enter the primary email address for the login you have specified
For the account description, you can enter a name that will allow you to identify the
mailbox in Outlook - e.g.: your mailbox name
4.7 An advanced check box is available to allow you to configure some additional settings. In
particular, the "Mailbox" field on the Mailbox tab allows you to optionally specify
another users mailbox to open (so you may access the resources of their mailbox while
logged in with your own credentials). Under normal configuration, you could leave this
field blank or the mailbox name associated with your own login. The other settings are
largely self-explanatory.

Initial Connection
When a connection is first made to the mail server by the client connector, all the mailbox contents
from the server are copied to the local profile. If you are connecting to a mailbox with a lot of email
data, be aware that it can take time to do the initial connection.

Sent Items Folder
The Sent Items folder is a special folder contained your sent messages. In order for this to work
correctly, Outlook must send email out directly through the MailEnable server. Some proxies may
prevent this from working. After installation and configuration of a profile, send a message with
Outlook. Then log into webmail and make sure the sent message is visible, and that you also see this
in your Outlook sent items folder. If you do see them in both, then the sent items functionality is
working.
When an email is sent, the MailEnable server makes a copy of the email and puts it into the mailbox
sent items folder on the server. The mailbox is determined by the account used to authenticate for
the send. To ensure that your sent items are synchronised to your own mailbox, your outbound
settings should match your mailbox settings. If you authenticate with a different username and
password for outbound email, then you sent items will be saved into that mailbox rather than your
own.
While you are able to copy items out of the Sent Items folder it will only make a copy of the message,
it will not remove it from the folder.

MailEnable Menu
The connector adds another menu item to Outlook, called MailEnable. The following menu items
can be accessed:
Open Resource: Opens the "Manage Resource Connections" dialog. For details, see the section
below titled "Connecting to a shared resource".
Remove Orphaned Cached Items: Only available when in troubleshooting mode, enabled on the
"Troubleshooting" tab of the "MailEnable Messaging Service Configuration" dialog. When selected,
removes items from the client that have lost their connection with the server. Use if you have a
folder that has items duplicated in it (rarely necessary).
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Refresh Folder List: Synchronises the list of folders between the client and the server.
Reset Folder From Server: Empties the currently selected folder from the client and downloads the
contents from the server.
Check Folder for New Messages: Performs a synchronisation with the server on the currently
selected folder, checking whether it is up to date, and downloading any missing messages, updating
changed messages, and removing deleted messages.
Out Of Office: Enable or disable and configure your server side out of office message that will be
automatically returned to anyone who sends you an email while you are unavailable. This alters the
autoresponder contents which are also accessible from webmail. If you have multiple accounts using
the connector configured, then this menu will affect the currently selected mailbox.

Sharing Resources
To share a folder in Outlook to another user, open the properties of that folder by right-clicking on
the folder, and selecting Properties from the context menu. In the folder properties window that
opens, select the Permissions tab. Click the Add button, and in the dialog that opens, select who
you wish to grant access to, and what level of access to afford them. Press the OK button to grant
the access, and OK again to close the folder properties dialog.
Additionally, you can perform the above procedure to grant access to your entire mailbox by rightclicking on the mailbox root and selecting its properties, and proceeding from there in the same
fashion as above.
NOTE: The Permissions tab is provided by the MailEnable Exchange Client Extension or COM add-in.
If you do not see this tab, ensure the MailEnable Exchange Client Extension is enabled (see the
section below title "Microsoft Outlook Addins").

Connecting to Shared Resource
If another user has given you permission to access one of their resources, you can connect to it by
accessing the "Manage Resource Connections" dialog. There are two ways of accessing this dialog.
From the MailEnable menu in Outlook, you can select the Open Resource menu option.
Alternatively, from the "MailEnable Messaging Service Configuration" dialog for your MailEnable
account, enable advanced configuration settings by ticking the box towards the bottom of the main
page, and then on the Mailbox tab that becomes available, click the Resource Connections button.
Once you have the "Manage Resource Connections" dialog, you will see a list of the resources to
which you have been granted access. Find the user in the list who owns the resource to which you
wish to connect, and add a tick next to their name. Then click the OK button on the "Manage
Resource Connections" dialog, and, if you accessed the dialog from the configuration dialog of the
MailEnable account, press the OK button on that dialog as well. You will be warned that you should
restart Outlook after making changes to resource connections. Click OK, and then restart Outlook.
After Outlook restarts, you will have access to an extra store for the user whose resource you
connected to. Expand this store to access the other users resources. Note that you access shared
resources in the same way that you access your own; in particular, to access special folders such as a
shared calendar, you must go to the "Calendar" view in Outlook, and select which calendar you wish
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to view from the list of available calendars in the navigation panel. The same applies to contacts and
tasks.

Appointment Sensitivity
The MailEnable mail server does not have all the permissions levels that would normally be available
when using Outlook with Exchange. So currently when you connect to a shared calendar you will not
be able to see any appointments that have a sensitivity level of Private, Confidential or Personal.

Accessing Public Folders
To access public folders, begin by accessing the "MailEnable Messaging Service Configuration" dialog
for your MailEnable account. Enable the advanced configuration settings by ticking the checkbox
towards the bottom of the main page, and then select the Mailbox tab that becomes available. Tick
the option for Enabled public folders.
You will now have access to the public folders as a separate mail store in Outlook.

Managing Server Side Files
To manage your server hosted files, begin by accessing the "MailEnable Messaging Service
Configuration" dialog for your MailEnable account. Enable the advanced configuration settings by
ticking the checkbox towards the bottom of the main page, and then select the Mailbox tab that
becomes available. Tick the option for Enabled server hosted file access.
You will now have access to your server hosted files in a separate mail store called "My Files". You
can download the files you have on the server by dragging them to a folder on your computer, or by
double-clicking on them in the list. You can also upload files from your computer by dragging them
onto the list of files or a folder in your My Files store in Outlook.
Your file store publishing can also be configured from within Outlook, the same as you can do in
webmail. To do this, right click on either the mail store “My Files” (if you wish to publish files in the
root directory), or right click one of the sub-folders, and select Properties from the context menu.
Select the Publishing tab in the window which appears and you can publish the folder via a URL link.

Offline Support
When a connection is not available to the server, you are still able to use Microsoft Outlook to read,
reply and to change flags for messages (the message has to have previously been downloaded to
Outlook for this to work). You are not able to do folder manipulation or delete messages.
Appointments, tasks and contacts can be created and edited. When a server connection is available
again, your previous changes will be synchronised with the server.

Microsoft Outlook Addins
Much of the behaviour provided by the connector is by Outlook addins. There are two alternative
addins, an Exchange Client Extension (not available in Outlook 2010), and a COM addin. They both
provide the same features. If neither addin is enabled, you will not have the full synchronisation
experience. The procedure for checking the state of the addins and enabling them varies with
different versions of Outlook.
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For Outlook 2003:
Select the Tools > Options menu. Click the Other tab in the window that appears, click the
Advanced Options button. Select the Add-In Manager button. In the Add-In Manager window that
opens, find the "MailEnable" entry and ensure it is ticked to enable it.
For Outlook 2007:
Go to the Tools menu and select the Trust Center. In the list on the left of the "Trust Center"
window, select Add-ins. In the drop down list labelled "Manage:" at the bottom of the right hand
panel, select Exchange Client Extensions and click the Go button. In the Add-In Manager window
that opens, find the "MailEnable" entry and ensure it is ticked to enable it.
For Outlook 2010:
Go to the File menu and select Options. In the window which appears, select the Add-ins option. In
the drop down list labelled "Manage:" at the bottom of the right hand panel, select COM Add-ins
and click the Go button. In the "COM Add-Ins" dialog that opens, look for the option MailEnable
Connector for Outlook Addin, and ensure it is ticked to enable it.
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Limitations
1. If the server is currently in Turkish regional settings and sharing is configured via webmail, then
those shared resources may not be accessible.
2. Empty contact groups created in webmail cannot be seen immediately in Outlook since webmail
does not generate the notification of this.
3. As with webmail, My Files cannot be shared as a resource.
4. Messages that have not been downloaded from the server will show only their downloaded size
when sorting, not their complete size.
5. In order for Sent Items folder to be synchronised with the server, the client must communicate
directly with the server over SMTP.
6. If emails sent are not being copied to the Sent Items folder on the server, then it is likely that
Outlook is not talking directly to the server. Antivirus programs (such as Nortons) or similar
proxies can block this from occurring since it uses extended SMTP commands to tell the server
to copy the sent message to the users Sent Items.
7. The Connector will always try to save messages to the Sent Items folder on the server, even if
Outlook is set to not save to Sent Items.
8. Exceptions to recurring appointments are only kept locally to Outlook. They are not shown in
webmail, as exceptions are not supported by webmail.
9. Recurring tasks can be created and used in Outlook, but are not synced to the server, as the
server does not support recurring tasks.
10. Mark All as Read for folder is not available.
11. Custom special folders are not supported by the connector. So you are unable to create your
own calendar, tasks or contact folders using the Connector.
12. If you are running a non-English version of Outlook, any secondary Connector accounts, or
shares, will have their special folders in English (i.e. you will have Calendar, Tasks, etc. in English).
13. The global directory is only loaded when Outlook starts. So new contacts added to the global
directory will not be visible immediately.
14. While you are able to copy items out of the Sent Items folder it will only make a copy of the
message, it will not remove it from the folder.
15. You are not able to select your own folder for Sent Items.
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FAQ
Q. When trying to save a reminder, I get an error indicating that the folder does not support this
type of item.
A. Reminders are only supported on the default store for the profile you are using. If you are
using multiple accounts in a profile, you can change the default by using the Mail control
panel applet.
Q. I get the following error when logging in “Access to the requested resource was denied. Please
verify that you have been granted full access to the resource:”.
A. This error can indicate that you are logging in with a username and password, but
accessing a different mailbox that you don’t have permission to view.
Q. While composing a message with a large attachment, Outlook seems to freeze for a while.
A. The Connector will save a message being composed to the Drafts folder depending on
your Outlook settings. Since the Drafts folder is stored on the server, the Connector will be
uploading it. You can increase the time before Outlook saves to Drafts in the Outlook
options.
Q. Which account are my Draft messages saved to?
A. If you have multiple MailEnable email accounts configured under the one profile then
draft messages will be stored in the default account.
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